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BAØI TAÄP 2 

 HEÄ DAÀM GHEÙP  
 Trong baøi taäp naøy, baïn seõ thöïc taäp giaûi baøi toaùn heä daàm gheùp vaø daàm ñôn giaûn sau ñoù 
baèng keát quaû thöïc teá seõ ñöa ra keát luaän, neân söû duïng loaïi naøo thì kinh teá nhaát. Baèng chöông 
trình Sap 2000 baïn coù theå ñöa ra moät thoâng soá chính xaùc, sau ñoù so saùnh moät caùch nhanh choùng 
vaø deå daøng ñeå ñöa ra phöông phaùp toái öu. Thaät vaäy, ñeå thaáy ñöôïc ñieàu ñoù nhö theá naøo baïn haõy 
tieán haønh giaûi hai baøi toaùn nhö hình minh hoïa beân döôùi :      

 
Heä daàm gheùp 

 
Heä daàm ñôn giaûn 

1. KHÔÛI ÑOÄNG SAP 2000 

Vaøo trình ñôn Start choïn > Programs > SAP 2000NonLinear khi ñoù maøn hình xuaát hieän 
nhö hình beân döôùi : 
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2. ÑÔN VÒ TÍNH 

� Khai baùo ñôn vò tính laø KN-m baèng caùch, baïn duøng chuoät nhaáp choïn vaøo tam giaùc 
beân phaûi phía döôùi cuûa maøn hình vaø choïn KN-m. 

3. CHOÏN MAÃU KEÁT CAÁU 

� Tröôùc tieân baïn vaøo trình ñôn 
File > New Model hay nhaán toå 
hôïp phím Ctrl + N ñeå xuaát hieän 
hoäp thoaïi Coordinate System 
Definition. 

 

 

 Hoäp thoaïi Coordinate System Definition xuaát hieän : 

 

           Trong hoäp thoaïi Coordinate System 
Definition baïn thöïc hieän khai baùo theo trình töï 
sau : 

• Nhaáp chuoät vaøo Cartesian  

• Trong muïc Number of Grid 
Spaces baïn nhaäp vaøo giaù trò 
nhö sau : Taïi X direction laø 
17, Y direction : 8, Z 
direction : 1 vaø nhöõng muïc 
coøn laïi baïn nhaäp giaù trò laø 1 
sau cuøng nhaáp choïn OK ñeå 
ñoùng hoäp thoaïi. 
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� Khi nhaáp choïn OK, maøn hình xuaát hieän hai cöûa soå laøm vieäc nhö hình beân döôùi khi 
ñoù baïn nhaáp choïn vaøo Close ñeå ñoùng cöûa soå beân traùi. 

 

�  Vaøo trình ñôn View > Set 2D 
View hay nhaán toå hôïp phím 
Shift + Ctrl + F1 ñeå xuaát hieän 
hoäp thoaïi Set 2D View. 

� Hoäp thoaïi Set 2D View xuaát 
hieän : 
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 Trong hoäp thoaïi Set 2D view, taïi Plane baïn duøng chuoät nhaáp choïn vaøo X-Z plane sau ñoù 
nhaáp choïn vaøo OK ñeå ñoùng hoäp thoaïi. 

Luùc baáy giôø vuøng laøm vieäc xuaát hieän maûng löôùi nhö hình sau : 

 

4. Vaøo trình ñôn Draw > Draw Frame  
Element khi ñoù baïn thaáy bieåu töïông 

 xuaát hieän. 
 

 Tieáp theo baïn di chuyeån chuoät vaøo vuøng laøm vieäc sau ñoù nhaáp vaø giöõ chuoät taïi vò trí nhö 
hình beân döôùi. Baây giôø baïn nhaáp choïn vaøo vò trí oâ thöù 6 theo truïc X, khi thaû chuoät ra baïn thaáy 
treân ñöôøng löôùi xuaát hieän hai nuùt maøu vaøng. 

 
Vò trí nhaáp chuoät 

 
Hình khi thaû chuoät 
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 Töông töï nhö vaäy, vaãn giöõ chuoät baïn veõ tieáp baèng caùch nhaáp choïn vaøo oâ löôùi thöù 2 theo 
truïc X nhö hình beân döôùi :  Baïn tieáp tuïc thöïc hieän cho ñeán khi veõ xong caùc ñöôøng thaúng thì nhaán 
phím ESC treân baøn phím ñeå keát thuùc leänh veõ. 

 

 

 

 Ñeå nhìn thaáy roõ baïn nhaáp choïn vaøo F7 treân baøn phím, keát quaû seõ nhö hình beân döôùi. 

 
Hình khi thöïc hieän xong 

5. HIEÅN THÒ CAÙC THOÂNG SOÁ  

Ñeå hieån thò caùc thoâng soá cuûa phaàn töû 
leân maøn hình, ñaàu tieân baïn vaøo trình ñôn View 
> Set Elements hay nhaán toå hôïp phím Ctrl + 
E, ñeå xuaát hieän hoäp thoaïi Set Elements. 
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 Hoäp thoaïi Set Elements xuaát hieän : 

 
 Trong hoäp thoaïi Set Elements baïn khai baùo trình töï caùc thoâng soá nhö sau : 

• Trong hoäp thoaïi Joints nhaáp chuoät vaøo Labels ñeå ñaùnh daáu choïn chöùc 
naêng hieån thò soá hieäu cuûa nuùt vaø phaàn töû. 

• Trong hoäp thoaïi Frames nhaáp chuoät vaøo Labels. Sau cuøng baïn nhaáp choïn 
vaøo OK ñeå ñoùng hoäp thoaïi. 

 
Caùc thoâng soá ñaõ hieån thò treân daàm 

6. KHAI BAÙO ÑIEÀU KIEÄN BIEÂN 

� Ñeå khai baùo ñieàu kieän bieân baïn duøng chuoät nhaáp choïn nuùt thöù 1 vaø nuùt thöù 3 nhö 
hình sau : 
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� Tieáp theo, vaøo trình ñôn Assign 
> Joint > Restraints. 

� Hoäp thoaïi Joint Restraints xuaát 
hieän. 

 

� Trong hoäp thoaïi Joint 
Restraints taïi muïc Fast 
Restraints baïn duøng chuoät nhaáp 
choïn vaøo Tab thöù ba nhö hình 
con troû chæ beân treân, sau cuøng 
baïn nhaáp choïn vaøo OK ñeå ñoùng 
hoäp thoaïi. 

 

 

 Tieáp theo baïn nhaáp choïn vaøo nuùt soá 2 vaø soá 4 nhö hình sau : 
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� Vaøo trình ñôn Assign > Joint > Restraints. 

Hoäp thoaïi Joint Restraints xuaát hieän. 

 

 Trong hoäp thoaïi Joint Restraints taïi muïc 
Fast Restraints baïn duøng chuoät nhaáp choïn 
vaøo Tab thöù hai tính töø traùi sang phaûi, sau ñoù 
baïn nhaáp choïn vaøo OK ñeå ñoùng hoäp thoaïi. 

 
Lieân keát daõ xuaát hieän treân daàm 

7. KHAI BAÙO CAÙC ÑAËC TRÖNG VAÄT LIEÄU 

� Vaøo trình ñôn Define > 
Materials ñeå xuaát hieän hoäp 
thoaïi Define Materials. 

� Hoäp thoaïi Define Materials 
xuaát hieän. 

 

� Trong hoäp thoaïi Define 
Materials taïi muïc Materials 
baïn nhaáp chuoät vaøo CONC, 
trong muïc Click to nhaáp chuoät 
vaøo Modify / Show Material ñeå 
xuaát hieän hoäp thoaïi Material 
Property Data. 
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Trong hoäp thoaïi Material Property Data taïi muïc Analysis Property Data baïn tieán 
haønh khai baùo nhö sau : 

• Mass per unit Volume nhaäp vaøo giaù trò : 0  

• Weight per unit Volume baïn nhaäp vaøo giaù trò  : 2.5  

• Modulus of elasticity : 2.65e6  

• Poissons ratio : 0.2  

• Tieáp theo nhaáp choïn OK ñeå ñoùng hoäp thoaïi Material Property Data. 

• Nhaáp choïn vaøo OK ñeå ñoùng hoäp thoaïi Define Materials. 

8. KHAI BAÙO ÑAËC TRÖNG HÌNH HOÏC VAØ GAÙN CHO PHAÀN TÖÛ DAÀM 

� Tröôùc tieân baïn vaøo trình 
ñôn Define > Frame 
Sections. 

� Hoäp thoaïi Define Frame 
Sections xuaát hieän. 

 

� Trong hoäp thoaïi Define 
Frame Sections taïi muïc 
Click to baïn duøng chuoät 
nhaáp choïn vaøo tam giaùc 
beân phaûi cuûa hoäp Add / 
Wide Flange ñeå choïn 
Add Rectangular nhö 
hình beân döôùi ñeå xuaát 
hieän hoäp thoaïi 
Rectangular Section. 
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 Hoäp thoaïi Rectangular Section xuaát hieän. 

 
 Trong hoäp thoaïi Rectangular Section baïn khai baùo theo trình töï sau: 

• Taïi muïc Section Name baïn nhaäp teân 0404. 

• Trong muïc Dimensions khai baùo tieát dieän cho coät baèng caùch nhaäp giaù trò 
vaøo muïc Depth laø 0.4, vaø muïc Width laø 0.4. 

• Taïi muïc Meterial nhaáp chuoät vaøo tam giaùc beân phaûi ñeå choïn loaïi vaät lieäu 
laø CONC. 

• Nhaáp choïn OK ñeå ñoùng hoäp thoaïi Rectangular Section. 

� Luùc baây giôø trong hoäp 
thoaïi Define Frame 
Sections ñaõ xuaát hieän teân 
daàm laø 0404 maø baïn ñaõ 
nhaäp vaøo. Nhaáp choïn OK 
ñeå ñoùng hoäp thoaïi Define 
Frame Sections. 

� Tieáp theo baïn duøng chuoät 
nhaáp choïn vaøo nhöõng 
phaàn töû thanh daàm nhö 
hình sau : 
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� Vaøo trình ñôn Assign > 
Frame > Sections. 

� Hoäp thoaïi Define Frame 
Sections xuaát hieän. 

 

 

� Trong hoäp thoaïi Define Frame Sections taïi muïc Name baïn duøng chuoät nhaáp vaøo 
chuoãi kyù töï 0404 sau ñoù nhaáp vaøo OK ñeå ñoùng hoäp thoaïi. 

 

]  

Hình khi thöïc hieän xong 
9. GAÙN TAÛI TROÏNG CHO DAÀM  

� Ñeå gaùn taûi troïng cho daàm, ñaàu 
tieân baïn vaøo trình ñôn Define > 
Static Load Cases. 
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Hoäp thoaïi Define Static Load Case Names xuaát hieän. 

 
 Trong hoäp thoaïi Define Static Load Case Names baïn thöïc hieän khai baùo nhö sau : 

• Nhaáp chuoät vaøo Change Load. 

 
• Taïi muïc Load baïn nhaäp vaøo chuoãi kyù töï TAP TRUNG, taïi muïc Self 

Weight Muliplier baïn nhaäp vaøo giaù trò laø 1, sau ñoù nhaáp chuoät vaøo Add 
new Load. 

• Thöïc hieän laàn thöù hai taïi muïc Load baïn nhaäp vaøo chuoãi kyù töï PHAN BO, 
sau ñoù nhaáp chuoät vaøo Add new Load. 

• Nhaáp choïn vaøo OK ñeå ñoùng hoäp thoaïi Define Static Load Case Names. 

� Gaùn taûi troïng cho daàm : Ñeå gaùn taûi troïng cho daàm ñaàu tieân baïn duøng chuoät nhaáp 
choïn vaøo phaàn töû thöù nhaát (tính töø traùi sang phaûi). 
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� Vaøo trình ñôn Assign > Frame Static Loads > Point and Uniform. 

 
 Hoäp thoaïi Point and Uniform Span Loads xuaát hieän : 

 
Trong hoäp thoaïi Point and Uniform Span Loads taïi muïc Load Case Name baïn duøng 

chuoät nhaáp choïn vaøo tam giaùc beân phaûi choïn TAPTRUNG. 
• Trong muïc Direction baïn choïn Global Z. 

• Nhaáp choïn vaøo Absolute Distance from End - I 

• Trong muïc Point Loads baïn khai baùo nhö sau : 
Distance 3 0 0 0 

Load -40 0 0 0 

• Sau cuøng nhaáp choïn OK ñeå ñoùng hoäp thoaïi. 

 
Taûi troïng ñaõ xuaát hieän treân phaàn töû 
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 Tieáp theo baïn duøng chuoät nhaáp choïn vaøo phaàn töû soá 3 nhö hình con troû chæ beân döôùi. 

 

� Tieáp theo, baïn gaùn löïc phaân boá leân phaàn töû baèng caùch vaøo trình ñôn Assign > 
Frame static Loads < Point and Uniform.  

 
 Hoäp thoaïi Point and Uniform Span Loads xuaát hieän : 

 
 Trong hoäp thoaïi Point and Uniform Span Loads taïi muïc Load Case Name baïn duøng 
chuoät nhaáp choïn vaøo tam giaùc beân phaûi choïn PHANBO, taïi muïc Point Loads baïn nhaáp choïn 
vaøo Relative Distance from En-I, trong muïc Uniform Load nhaäp vaøo giaù trò laø –10, sau ñoù 
nhaáp choïn OK ñeå ñoùng hoäp thoaïi Point and Uniform Span Loads. 
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Taûi troïng phaân boá ñaõ xuaát hieän treân daàm 

10.KHAI BAÙO BAÄT TÖÏ DO 
Khai baùo baät töï do baèng caùch baïn vaøo trình ñôn Analyze > Set Options 

 
Hoäp thoaïi Analyze Options xuaát hieän : 

 

Trong hoäp thoaïi Analyze Options baïn thöïc hieän theo trình töï sau : 
• Taïi muïc Available SOFs (caùc thoâng soá veà baät töï do theo caùc phöông)baïn 

duøng chuoät nhaáp choïn vaøo UZ vaø RY(nhö trong hoäp thoaïi treân). 
• Nhaáp chuoät vaøo Generate Output sau ñoù nhaáp choïn Select Output 

Options ñeå xuaát hieän hoäp thoaïi Select Output Results. 
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Hoäp thoaïi Select Output Results xuaát hieän :  

 

• Trong hoäp thoaïi Select Output Results duøng chuoät nhaáp choïn vaøo 
Displacements ñeå ñöa thoâng soá chuyeån vò taïi nuùt ra file keát quaû, sau ñoù nhaáp 
choïn vaøo Select/ Show Loads ñeå xuaát hieän hoäp thoaïi Select Output. 

 

 Trong hoäp thoaïi Select Output baïn nhaáp choïn vaøo LOAD1 Load Case sau ñoù nhaán 
phím Ctrl vaø duøng chuoät nhaáp choïn PHANBO vaØ TAPTRUNG sau ñoù choïn OK ñeå ñoùng hoäp 
thoaïi. 

• Nhaäp chuoät vaøo Reaction/ Spring Forces vaø thöïc hieän laïi böôùc treân. 

• Töông töï nhaáp choïn vaøo Frame Forces ñeå ñöa ra noäi löïc cuûa phaàn töû Frame 

• Sau cuøng nhaáp choïn OK ñeå ñoùng hoäp thoaïi Select Output. 

• Nhaán choïn vaøo OK laàn hai ñeå ñoùng hoäp thoaïi Select Output Results. 

� Tieáp theo baïn vaøo trình ñôn Analyze < Run hay duøng phím F5 treân baøn phím ñeå 
giaûi baøi toaùn. 
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Hoäp thoaïi Save Model File As xuaát hieän : 

 
Trong hoäp thoaïi Save Model File As taïi muïc Save in baïn chæ ñöôøng daãn ñeå löu file, 

trong muïc File name baïn ñaët teân cho file laø “dam gheùp”vaø nhaáp choïn Save ñeå file ñöôïc löu. 

Khi maùy giaûi xong seõ xuaát hieän hoäp thoaïi coù doøng chöõ Analysis Complete luùc baáy giôø 
baïn nhaáp choïn OK ñeå xem chuyeån vò cuûa daàm. 

 

11. XEM KEÁT QUAÛ BIEÅU ÑOÀ  

Ñeå xem keát quaû baïn vaøo trình ñôn Display > Show Element Forces/ Stresses > Frames 
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 Hoäp thoaïi Member Force Diagram for Frames xuaát hieän : 

 

Trong hoäp thoaïi Member Force Diagram for 
Frames taïi muïc Load baïn nhaáp vaøo tam giaùc 
beân phaûi ñeå choïn PHAN BO sau ñoù baïn duøng 
chuoät nhaáp choïn vaøo Momen 3-3 ñeå xem 
momen xoaén quanh truïc ñòa phöông 3, nhaáp 
chuoät vaøo Show Values on Diagram vaø choïn 
vaøo OK ñeå ñoùng hoäp thoaïi. 

 
 Töông töï nhö vaäy baïn giaûi tieáp cho daàm ñôn giaûn baèng caùch baïn thöïc hieän laïi töøng böôùc 
soá 1 ñeán böôùc thöù 4 ñeå veõ daàm nhö beân döôùi. 

 
 Sau khi veõ daàm xong baïn thöïc hieän laïi böôùc thöù naêm nhö hình sau :  
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12. KHAI BAÙO ÑIEÀU KIEÄN BIEÂN 

� Ñeå khai baùo ñieàu kieän bieân baïn duøng chuoät nhaáp choïn nuùt thöù 1 vaø thöù 4 nhö hình 
beân döôùi :  

 
Vò trí nhaáp chuoät 

� Vaøo trình ñôn Assign > Joint > Restraints. 

 
Hoäp thoaïi Joint Restraints xuaát hieän. 

 
 Trong hoäp thoaïi Joint Restraints taïi muïc Fast Restraints baïn duøng chuoät nhaáp choïn 
vaøo Tab thöù hai nhö hình con troû chæ beân treân, sau cuøng baïn nhaáp choïn OK ñeå ñoùng hoäp thoaïi. 
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 Töông töï nhö vaäy baïn nhaáp choïn vaøo nuùt thöù 2 vaø 3. 

 
Baây giôø vaøo trình ñôn Assign > Joint > Restraints. 

Hoäp thoaïi Joint Restraints xuaát hieän : 

 
  Trong hoäp thoaïi Joint Restraints taïi muïc Fast Restraints baïn duøng chuoät nhaáp choïn vaøo 
tab thöù 3 nhö hình con troû chæ beân treân vaø nhaáp choïn OK. 
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 Baây giôø baïn thöïc hieän laïi töø böôùc 7 ñeán böôùc 9. 

 
13. KHAI BAÙO TAÛI TROÏNG CHO DAÀM 

• Tröôùc tieân baïn duøng chuoät nhaáp choïn vaøo phaàn töû ñaàu tieân nhö hình sau :  

 
•  Baây giôø baïn goïi leänh Assign > Frame Static Loads > Point and Uniform 

 Hoäp thoaïi Point and Uniform Span Loads xuaát hieän : 
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Trong hoäp thoaïi Point and Uniform Span Loads taïi muïc Load Case Name baïn duøng 
chuoät nhaáp choïn vaøo tam giaùc beân phaûi choïn TAPTRUNG. 

• Trong muïc Direction baïn choïn Global Z. 

• Nhaáp choïn vaøo Absolute Distance from End - I 

• Trong muïc Point Loads baïn khai baùo nhö sau : 

Distance 3 0 0 0 

Load -40 0 0 0 

• Sau cuøng nhaáp choïn Ok ñeå ñoùng hoäp thoaïi. 

 
 Töông töï nhö vaäy baïn nhaáp choïn vaøo phaàn töû thöù hai sau ñoù thöïc hieän laïi böôùc khai baùo 
taûi troïng phaân boá nhö trong böôùc 9. 

 
Nhaáp chuoät vaøo phaàn töû soá 2 

 
 Taûi troïng phaân boá xuaát hieän treân phaàn töû soá hai 
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 Baây giôø baïn thöïc hieän laïi töø böôùc 10 vaø 11 cho ñeán khi hoäp thoaïi Save Model File As 
xuaát hieän. 

 Hoäp thoaïi Save Model File As xuaát hieän : 

 

Trong hoäp thoaïi Save Model 
File As taïi muïc Save in baïn 
chæ ñöôøng daãn ñeå löu file, 
trong muïc File name baïn 
ñaët teân cho file laø “dam don 
gian”vaø nhaáp choïn Save ñeå 
löu vaø ñoùng hoäp thoaïi. 

  Maùy tieán haønh giaûi baøi toaùn, khi hoäp thoaïi Analysis Complete xuaát hieän baïn nhaáp choïn 
vaøo OK ñeå xem chuyeån vò cuûa daàm. 
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14. XEM BIEÅU ÑOÀ NOÄI LÖÏC 

Tieáp theo baïn vaøo trình ñôn Display > Show Element Forces/ Stresses > Frames 

 Hoäp thoaïi Member Force Diagram for Frames xuaát hieän : 

 
 Trong hoäp thoaïi Member Force Diagram for Frames taïi muïc Load baïn nhaáp choïn 
TAPTRUNG vaø nhaáp chuoät vaøo Moment 3-3 sau cuøng nhaáp choïn OK ñeå ñoùng hoäp thoaïi. 

 
 Baïn thöïc hieän laïi böôùc 11 ñeå xem bieåu ñoà momen.  
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15. SO SAÙNH  

 
Bieåu ñoà moment cuûa daàm gheùp 

 
Bieåu ñoà moment cuûa daàm ñôn giaûn 

 Baïn thaáy hai daàm coù cuøng nhòp vaø chòu taûi troïng töông ñöông nhöng moâmen lôùn nhaát 
trong daàm gheùp laø 50.91 kNm trong khi ñoù momen lôùn nhaát cuûa daàm ñôn giaûn laø 80kNm, ñieàu 
ñoù cho ta thaáy duøng daàm gheùp coù khaû naêng tieát kieäm vaät lieäu hôn so vôùi duøng daàm ñôn giaûn coù 
ñieàu kieän laøm vieäc töông ñöông. 

 Chuùc möøng baïn ñaõ hoaøn taát baøi taäp. 
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